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ABSTRACT
This application report describes the setup and procedures to measure power consumption on CC2650,
CC2640 and CC2640R2F devices operating as a Bluetooth® low energy “Peripheral” device.

The Power Calculation Tool discussed in the application report can be found from the following URL:
www.ti.com/ble-power-calculator.
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1 Introduction
The Bluetooth low energy standard was developed with long battery life in mind, allowing devices to last
several years while operating on a single coin-cell battery. It is assumed the reader of this application
report has some knowledge of the BLE standard, as well as the Texas Instruments SimpleLink™
Bluetooth low energy CC2640 and CC2640R2F wireless microcontroller (MCU) with the Software
Development Kit BLE-Stack.

In addition, it is assumed that the reader has some knowledge of basic electrical engineering concepts,
and understands how to use laboratory test equipment such as an oscilloscope and DC power supply.

Power consumption measurements are presented, and battery life time is calculated for an example
application. An accompanying Power Calculation Tool is provided so that you can estimate your battery
life based on your own custom usage scenario.

Note that the results presented in this document are intended as guidelines. A variety of factors will
influence the battery life of a Bluetooth low energy product. Measurements should be performed on
hardware in a controlled environment, and under the target application scenario.

Also note that all waveforms and power consumption measurement results presented in this application
report may not be up to date with the latest software optimizations.
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1.1 Acronyms

Table 1. Acronyms Used in this Document

Acronym Description
CM3 Cortex-M3
CPU Central Processing Unit
DC Direct Current
DK Development Kit
DUT Device under Test
EM Evaluation Module
GAP Generic Access Profile
GPIO General-Purpose Input/Output
MCU Microcontroller Unit
PC Personal Computer
RF Radio Frequency
RISC Reduced Instruction Set Computer
RTC Real Time Clock
RTOS Real Time Operating System
RX Receive
SCA Sleep Crystal Accuracy
TX Transmit

2 Understanding Bluetooth Low Energy Power Metrics
A Bluetooth low energy device achieves low power consumption by keeping radio activity short and
allowing the device to reside in standby or power down mode most of the operating time.

The operation of a Bluetooth low energy device is typically static in the sense that it’s staying in a certain
mode for a certain amount of time, example when advertising or maintaining a connection. These modes
are based on re-occurring events that can easily be used to estimated average power consumption. Each
of these modes can be quantified into states for future estimations based on added data throughput or
reduced latency (through higher connection interval, as an example).

The primary metric is the average current for the advertising and connected mode. It is these values that
can be used to determine the battery life of a Bluetooth low energy device.

For a wireless MCU, such as the CC2650, it is important to understand that the device is typically not only
running the Bluetooth low energy protocol stack, but it is also profile services and an application. The
application may also be using peripherals on the chip, such as SPI or ADC. In addition, other devices on
the circuit board, aside from the device running the Bluetooth low energy protocol stack, may be drawing
current as well.

There are three main components of a Bluetooth low energy application that together sum up the average
power consumption: Standby, Protocol Events and Application Events. Depending on the use case of the
Bluetooth low energy device, these components will consume different amounts of power.

http://www.ti.com
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Figure 1 is based on a measurement of the current draw for a connected Bluetooth low energy device.
The device spends most of the time in Standby, where the average current consumption is around 1 µA.

Figure 1. Current Consumption versus Time During a BLE Connection

From Standby the device only wakes up based on either external interrupts or scheduled events/interrupts
from the RTC. Standby also includes the recharge, which is further described in Section 5.3.2.

The Protocol Event is where communication over the Bluetooth low energy protocol occurs. For a
Bluetooth low energy device, these events can be either Advertising Events or Connection Events. There
are multiple roles featured that allow a Bluetooth low energy device to enter Observer role and scan as
well but they are not covered in this application report

The Application Event is the application specific implementation, for example, a periodic event, serial
communication or running algorithms based on sensor inputs. Depending on the amount of activity, the
application event may increase power consumption significantly, so always aim to optimize processing
usage. The Application Events typically occur in between protocol events, which mean that a longer
advertising or connection interval will give longer time slots for processing.

3 SimpleLink Bluetooth Low Energy Wireless MCUs
There are several Bluetooth low energy Solutions provided by Texas Instruments. These cover a wide
range of solutions from simple broadcaster only to advanced multiple-role Real Time Operating System
(RTOS) featured solutions, as shown in Table 2.

(1) Single-ended RF mode is optimized for size and power consumption. Measured on CC2650EM-4XS.

Table 2. Bluetooth Low Energy Solutions from Texas Instruments

CC2540 CC2540T CC2541 CC2541-Q1 CC2543 CC2544 CC2640
Max Output
Power

+4dBm +4dBm 0 dBm 0 dBm +5 dBm +4 dBm +5 dBm

TX current (0
dBm)

26 mA 26 mA 18.2 mA 18.2 mA 26 mA 27 mA 6.1 mA (1)

Size (QFN) 6x6 6x6 6x6 6x6 5x5 5x5 4x4, 5x5, 7x7
BLE-Stack
Support

Yes Yes Yes Yes Broadcast only Broadcast only Yes

USB 2.0 Yes Yes - - - Yes -
Key Features USB High Temp.

<125°C
I2C + Lower

power
Automotive
Qualified

Low cost Low cost +
USB

RTOS +
Lowest power

This application report focuses on the CC2640, CC2640R2F and its superset device CC2650.

The CC2640/CC2640R2F is a Bluetooth low energy Wireless MCU providing a complete solution on a
single chip. It runs three cores, which can be separately powered and controlled. The application
processor is an ARM® Cortex®-M3 and it is used for running the Bluetooth low energy Profiles along with
any user defined functionality. Application and part of the Bluetooth low energy protocol stack is sharing
20kB of RAM and up to 128kB of Flash.

http://www.ti.com
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Figure 2. CC26xx Architectural Overview

The RF core ensures that all timing regarding the Bluetooth low energy protocol is being configured and
handled properly. An ARM Cortex-M0 is dedicated for the radio operations and runs the BLE Radio
Firmware from its own dedicated ROM.

The Sensor Controller includes a small proprietary RISC CPU that has been design to off-load the Cortex-
M3. When the rest of the system is in standby, it can run small algorithms or communicate with sensors in
a low power manner. It can wake up on interrupt and perform some simple processing and wake up the
CM3 based on sensor input.

The Peripheral and Serial domain includes a wide set of peripheral modules, for serial communication, as
well as general purpose IOs and timers.

The CC2650 can be powered by two supply ranges, as presented in Table 3. To enable the 1.8 V system,
both hardware and software modifications are required, which is documented in the CC13xx, CC26xx
SimpleLink™ Wireless MCU Technical Reference Manual [2].

Table 3. CC2650 Supply Voltage

Supply Voltage Internal DCDC Minimum Maximum
1.8 V System (External
Regulator Mode)

No 1.7 V 1.95 V

3.3 V System Optional 1.80 V 3.80 V

http://www.ti.com
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For more information about CC2640, CC2640R2F and CC2650, see the CC2640 [3], CC2640R2F [4] and
CC2650 Data Manuals [5], respectively.

4 Power Measurement Setup – Preparing the DUT
Before measurement and analysis can be performed, the device under test (DUT) must be prepared both
from a hardware and software perspective. A peer device may also be configured in order to establish a
connection. In this application report, a device running the example project HostTest is used to establish
the connection. This project can be run on the CC2650/CC2640R2 LaunchPad, a CC2650EM or a
CC2540 USB Dongle.

Figure 3. Device Under Test

4.1 Requirements
To measure average power consumption for Bluetooth low energy, the following hardware from Texas
Instruments are required:
• CC2650EM and SmartRF06EB

Or
• CC2650/CC2640R2 LaunchPad

And
• A device running HostTest project (for example, CC2650/CC2640R2 LaunchPad, CC2650EM mounted

on SmartRF06EB or CC2540 USB Dongle) - Optional

CC2650EM and SmartRF06EB are included in the CC2650DK that can be purchased at the TI Store [6].
The CC2650/CC2640R2 LaunchPad (LP) can also be purchased at the TI Store. Note the difference of
CC2650 and CC2640. The CC2650DK and the CC2650LP include the CC2650 multi-platform MCU
evaluation module. The CC2650 is the superset device, which supports multiple protocols including
Bluetooth low energy, and it can be interchanged with a CC2640 when working solely on a Bluetooth low
energy application. So for a Bluetooth low energy solution, CC2650 and CC2640 are identical.

In terms of software resources, the following are required:
• BLE-Stack [7]
• IAR EWARM v.7.70.2 (or later) [8]

or
• CCS Integrated Development Environment [9]

http://www.ti.com
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4.2 Embedded Software
The BLE-Stack is the Software Development Kit (SDK) for the CC26xx Bluetooth low energy devices
provided by Texas Instruments. The software package includes full Bluetooth low energy (BT4.2) protocol
stack along with sample applications. The protocol stack is provided as a pre-qualified library component
and the complete system is operated by a RTOS that introduces a threaded environment with full power
management. The power management is maintained by the RTOS automatically and the application can
constrain tasks or disallow certain power modes if required. The power modes are presented in Table 4.

Table 4. CC2650 Power Modes

Power Mode Description Current
Active System CPU is running 1.45 mA + 31

µA/MHz
Idle The power domain in which CPU resides is off 550 uA
Standby The voltage domain in which CPU resides is off 1 uA
Shutdown Only IOs maintain their operation. All voltage regulators, voltage and power domains are off 0.1 uA

The generic sample application simple_peripheral that is included with the BLE-Stack is ideal to use in
order to analyze power consumption for the sole Bluetooth low energy protocol running on a wireless
MCU. To get a clean Bluetooth low energy protocol analysis, some modifications are required within the
simple_peripheral sample application as observed in Table 5. This is needed because the purpose is to
measure current consumption resulting from the BLE stack alone, so additional application processing
must be turned off. The GPIO pins are per default already in a power-optimized state after board
initialization. However, if you are using the CC2650LP or CC2640R2LP external flash needs to be turned
off as it is enabled by default.

Table 5. Software Modifications Required, SimpleBLEPeripheral

Feature Description
Periodic Event The only application processing that occurs is a periodic event that starts once a connection has been

established. To eliminate the periodic event from the application, simply comment out the following line
of source code from the GAPROLE_CONNECTED case in the
SimpleBLEPeripheral_processStateChangeEvt function in the file simple_peripheral.c:

//Util_startClock(&periodicClock);
By commenting out this line, the RTOS timer for the first periodic event will never get set.

LCD Disable all screens by adding Display_DISABLE_ALL in the predefined symbols. In CCS go to Project
Properties → Build → ARM Compile → Advanced Options → Predefined Symbols → Pre-define NAME.
In IAR go to Project Options → C/C++ Compiler → Preprocessor → Defined symbols.

Connection Parameter Update There is an automatic connection parameter request being sent from the peripheral device shortly after
a connection has been established. It uses the parameters defined in simple_peripheral.c. For the
measurement, it is more convenient to remove this feature and directly control connection parameters
from the peer device.
In simple_peripheral.c, change DEFAULT_ENABLE_UPDATE_REQUEST define to
GAPROLE_LINK_PARAM_UPDATE_WAIT_REMOTE_PARAMS as shown below:

#define DEFAULT_ENABLE_UPDATE_REQUEST
GAPROLE_LINK_PARAM_UPDATE_WAIT_REMOTE_PARAMS

[CC2650LP/CC2640R2LP only]
Add ExtFlash.c and ExtFlash.h

ExtFlash.c and ExtFlash.h are located in the TI-RTOS middleware (for CC2650LP, files are located at
C:\ti\tirtos_cc13xx_cc26xx_2_18_00_03\products\tidrivers_cc13xx_cc26xx_2_16_01_13\packages\ti\mw\
extflash\ . For CC2640R2LP, files are located at
C:\ti\simplelink_cc2640r2_sdk_1_00_00_22\source\ti\mw\extflash). Add them to the SBP application
project by going to Project → Add Files (only possible in CCS Edit, not CCS Debug). Also, include them
in simple_peripheral.c with the command:
#include <ti/mw/extflash/ExtFlash.h>

[CC2650LP/CC2640R2LP only]
Close external flash

Open and close the external flash by calling
ExtFlash_open();
ExtFlash_close();

in
SimpleBLEPeripheral_init().

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SWRA478C


Power Measurement Setup – Preparing the DUT www.ti.com

8 SWRA478C–February 2015–Revised January 2017
Submit Documentation Feedback

Copyright © 2015–2017, Texas Instruments Incorporated

Measuring Bluetooth Low Energy Power Consumption

For more information including instructions on how to program the CC2650, CC2640 and CC2640R2F,
see the Software Developers Guide [1].

4.3 Hardware

4.3.1 SmartRF06
The SmartRF06 board includes many peripheral features. To get a clean measurement, it is important to
remove a couple of jumpers as presented in Table 6; the visual location is observed in Figure 4. If these
jumpers are not removed, there will be an additional current draw.

Table 6. SmartRF06 Jumper Removal

Function Jumper on SmartRF06 Comment
JTAG P408 Note that this disables JTAG, which means that programming and debug capabilities

become unavailable.
EM GPIO P403, P404 and P405 Not all jumpers need to be removed, but for simplicity, it is better to remove them all.
UART J5 UART enable

Figure 4. SmartRF06 Board Jumper Removal

http://www.ti.com
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Make sure to double check whether the EM needs an antenna or if it is using a PCB antenna. This is
verified by observing R10/R11 on the EM, as shown in Figure 5.

Figure 5. CC2650EM Antenna Option

NOTE: In SmartRF06 v121 and older, a small op amp is mounted next to R502. In that case,
remove it or it will increase the power consumption during the measurement.

http://www.ti.com
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4.3.2 CC2650/CC2640R2 LaunchPad
To get a clean current measurement, the jumpers on the CC2650LP and CC2640R2LP should be
removed. The Launchpad with all jumpers removed is showed in Figure 6. Note that when the JTAG
jumpers are removed, the programming and debug capabilities of the chip become unavailable.

Figure 6. CC2650 LaunchPad Jumper Removal

Figure 6 applies for users that have CC2640R2 LP.

4.4 BTool (Optional)
The BLE-Stack also includes BTool along with drivers and firmware. BTool can be used to emulate a
Bluetooth low energy application from a PC environment. BTool is used to create a connection with the
DUT and if the intention is to measure power consumption of the DUT being in advertising or beacon
mode, BTool is not required.

To connect to the DUT using BTool, a device running a Bluetooth low energy wireless network processor
image named HostTest is required. This can be found with the other example projects in the BLE-Stack.

If you want to run HostTest on a CC2540 USB Dongle, the firmware image is found in the default install
directory of the 1.4 BLE-Stack (\Accessories\HexFiles\CC2540_USBdongle_HostTestRelease_All.hex). (It
is also bundled with the Device Monitor installer
(http://processors.wiki.ti.com/index.php/BLE_Device_Monitor_User_Guide). To program the CC2540USB
Dongle, use SmartRF Flash Programmer 1 (http://www.ti.com/tool/flash-programmer). If the CC2540 USB
Dongle is running the correct firmware, the LED on it should be lit red. (If the CDC Driver for the CC2540
USB Dongle does not automatically install, it is located in the default install directory of the 1.4 BLE-Stack
(\Accessories\Drivers)).

With dongle connected to the PC, open up BTool. Choose the correct COM port that the HostTest device
has been connected to.

http://www.ti.com
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Figure 7. BTool Serial Port Settings

Press OK and there should be an initialization process that is observed in the log window.

Before forming the connection, the proper connection parameters should be used. This will be dependent
on the application that is being considered. The supervision timeout setting should not affect the power
measurements. A connection interval of one second, with zero slave latency, will be used in this
document. Therefore, use the values as shown in Figure 8. Be sure to select the “Set” button after
entering in the values. Setting up the connection parameters needs to be done before a connection is
established.

Figure 8. BTool Connection Settings

With the connection parameters set as needed, setup is completed.

http://www.ti.com
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At this point, BTool is ready to discover the DUT. If you left the SimpleBLEPeripheral application running
on your DUT, you should be ready to use BTool. As long as the device running SimpleBLEPeripheral is
powered up and not connected to anything, it should be in discoverable (advertising) mode.

In the Discovery section, press the “Scan” button, as shown in Figure 9.

Figure 9. BTool Scan

BTool will begin searching for Bluetooth low energy devices. After a couple of seconds, the device
discovery process will finish. Alternatively, if you do not want to wait through the full 10 seconds of
scanning, the “Cancel” button can be pressed, which will stop the device discovery process. The address
of any scanned devices will appear in the “Slave BDA” section, as shown in Figure 10.

Figure 10. BTool Scan Results

To establish a connection with the peripheral device, select the address of the device to connect with, and
click the “Establish” button, as shown in Figure 11.

Figure 11. BTool Establish Link

http://www.ti.com
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As long as the peripheral is powered-up and still in discoverable mode, a connection should immediately
be established. Once a connection is established, the message window will return a “GAP_EstablishLink”
event message with a “Status” value of “0x00 (Success)”. In BTool, you can see your connected
peripheral device in the Device Information field, as shown in Figure 12.

Figure 12. BTool Connected Device

5 Measuring Power Consumption With a DC Power Analyzer
The easiest way of measuring power consumption is to utilize a DC Power Analyzer, which is far more
advanced than a simple multimeter. Because the power consumption varies over time, a simple
multimeter would not be sufficient anyway. An oscilloscope can be used as well, although the sampling
rate and bandwidth must be good enough. For the purpose of this application report, an Agilent N6705B
DC Power Analyzer is used (see Figure 13). The internal module is a N6781A, a 2-quadrant source and
measure unit for battery drain analysis.

Figure 13. Agilent N6705B DC Power Analyzer

http://www.ti.com
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5.1 Test Setup
Make sure that the system is set up properly and review the steps described in Section 4. For reference,
the full overview is illustrated in Figure 14. Note that the VDD is connected to the pin referred to as “VDD
TO EM” on the SmartRF06. For the CC2650LP and CC2640R2LP, connect the VDD to the 3V3 pin.

When the DUT is correctly connected, the power supply is enabled by pressing the “On” button within the
Agilent 14585A Control and Analysis Software. The power consumption measurements can be done by
two separate functions: Scope or Data Logger. Data Logger provides an average power consumption
measurement over longer time, for example minutes and hours, although the resolution is not as good as
using Scope. This document focuses on doing measurements by using the Scope feature.

Figure 14. DUT Test Setup

The Agilent N6705B powers the DUT as well as performs the current measurement.

http://www.ti.com
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5.1.1 Analysis Software Setup

All measurements and analysis can be done directly with the Agilent N6705B interface, but in this
application report a PC Tool is used to control the Agilent N6705B. The PC Software used to control the
Agilent N6705B is “Agilent 14585A Control and Analysis Software” v2.0.2.1. All software can be
downloaded at http://www.keysight.com/ (in 2014, Agilent electronics instruments division was acquired by
Keysight Technologies).

When the PC Tool is started, no external equipment is connected, which is observed in the “Instrument
Control Tab”, as shown in Figure 15.

Figure 15. Agilent 14585A Control and Analysis Software, Start-Up

To connect the Agilent N6705B, make sure that it is connected via USB and that it is powered. Use the
bottom left “Connect” button to select the connected hardware, as shown in Figure 16.

Figure 16. Agilent 14585A Control and Analysis Software, Connect

http://www.ti.com
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When the hardware has been successfully connected, it is fully controlled from the PC Tool, which is
verified by the “Instrument Control” tab, as shown in Figure 17.

Figure 17. Agilent 14585A Control and Analysis Software, Connected

http://www.ti.com
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Note that the Output may be “On” per default (observed by the lit “on” button). If so, turn the Output off
since the actual output parameters have not been configured yet. The next step is to configure the output.
In the “Instrument Control” tab, click the “Settings” button to bring up the Source Settings for Output 1.
Depending on the module within the Agilent N6705B, the options may be limited. Select “2 Quadrant
Power Supply” and set the “Voltage” to 3V.

Figure 18. Agilent 14585A Control and Analysis Software, Source Settings

http://www.ti.com
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Connect the instrument probes to the DUT. For the SmartRF board, The VDD line goes to the “VDD TO
EM” pin. The GND is most easily connected to the GND plane of the SmartRF06 board (see Figure 19).

For the CC2650/CC2640R2 LaunchPad, the VDD line should be connected to the 3V3 pin. The GND can
be connected to any GND pin on the CC2650/CC2640R2 LP. Connecting to the CC2650/CC2640R2 LP is
shown in Figure 20.

Figure 19. Connecting the SmartRF06 Evaluation Board to Agilent 14585A

Figure 20. Connecting CC2650/CC2640R2 LaunchPad
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When the DUT is correctly connected, the power supply is enabled by pressing the “On” button within the
Agilent 14585A Control and Analysis Software. The power consumption measurements can be done by
two separate functions: Scope or Data Logger. Data Logger provides an average power consumption
measurement over longer time, for example, minutes and hours, although the resolution is not as good as
using Scope. This document focuses on doing measurements by using the Scope feature.

Figure 21. Connected DUT to Agilent 14585A

5.2 Measurement Using Scope
When the instrument has been correctly setup and configured, make sure that Scope has been selected,
as shown in Figure 22.

Figure 22. Agilent 14585A Control and Analysis Software, Scope

The scope mode allows that measurement be ran over a short amount of time. In order to maximize the
amount of data, setup the parameters (see Figure 23).
• Resolution: 200ms / div
• Points: 512k
• Trigger: Scope Run Button
• Mode: Single
• Slope: Rising Edge

Figure 23. Agilent 14585A Control and Analysis Software, Scope Setup
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Next, make sure that the “Ranges…” is setup to AUTO, as shown in Figure 24.

Figure 24. Agilent 14585A Control and Analysis Software, Instrument Range

The instrument should now be setup properly and the measurement can start. Click the Play button in the
bottom right corner → allow the instrument to start the measurement.

5.3 Analysis
Depending on what the DUT is setup to do, the result will vary. If no interaction has been made with the
DUT, it will be sending out periodic advertisements each 100 ms.

Figure 25. Agilent 14585A Control and Analysis Software, Advertisement Capture

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SWRA478C


www.ti.com Measuring Power Consumption With a DC Power Analyzer

21SWRA478C–February 2015–Revised January 2017
Submit Documentation Feedback

Copyright © 2015–2017, Texas Instruments Incorporated

Measuring Bluetooth Low Energy Power Consumption

The approximately 2.66s measurement includes 26 advertising events and in between, during Standby,
there is a recharge pulse.

There is functionality to do detailed measurements of the acquired waveform. Select “Markers &
Measurements” to enable the markers, which can be used to obtain average power consumption. There
are two approaches of using the markers:
• Measure the average power consumption from a symmetric point of the measurement, (for example,

from the start of an event to the point where the next event starts). This will give an approximation of
the overall power consumption over time because of the reoccurring symmetry.

• Break down the events into states to be used for various use case studies and estimations. This is
very useful in order to analyze the resulting power consumption when intervals are changed

If the objective is to simply obtain a power consumption figure of the DUT, the first option is fast and
reliable.

5.3.1 Advertising Event
An advertising event is where the (Bluetooth low energy) peripheral device broadcasts information in order
to either share information or become connected to a (Bluetooth low energy Ready) Central device, such
as a smart phone. The device wakes up and broadcasts packets on three separate channels and listens
on each of these channels for Scan Requests or Connection Requests. Scan requests is a way for a
Central device to obtain more information about the device before connecting, because the advertising
data is typically chosen to be very short to minimize power consumption. Based on advertising data or the
scan response data, connection requests can be sent, which initiates a connection between the Peripheral
and the Central.

With connectable advertising packet format, the base time of data transmitting is 144 µs which contains 1
byte preamble, 4 bytes Access Address, 2 bytes PDU, 3 bytes CRC and 6 bytes AdvA in the payload. For
every additional transmitted bit, 1 µs should be added to the TX time.

The Agilent 14585A Control and Analysis Software “Markers & Measurements” functions are used to
quantify a single advertising event, which is visualized in Figure 26 and summarized in Table 7.

Figure 26. Connectable Advertising Event, Capture
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Table 7. Advertising Event, State Analysis

State Time [µs]
Current

[mA] Comments
1 pre-processing 1160 3.26 RTOS wake-up, radio setup, XTAL guard time
2 Radio preparation 101 4.3 Radio is turned on and in transition to TX
3 TX 168 7.47 Tha radio transmits an advertisment packets with 3 bytes data on Channel

37. Time is dependent on amount of transmitted data
4 TX to RX transition 112 4.66 TX to RX transition
5 RX 184 6.47 Time depends on advertising interval and SCA
6 RX to TX transition 370 3.43 RX to TX transition
7 TX 168 7.47 Tha radio transmits an advertisment packets with 3 bytes data on Channel

38. Time is dependent on amount of transmitted data
8 TX to RX transition 112 4.66 TX to RX transition
9 RX 184 6.47 Time depends on advertising interval and SCA
10 RX to TX transition 370 3.43 RX to TX transition
11 TX 168 7.47 Tha radio transmits an advertisment packets with 3 bytes data on Channel

39. Time is dependent on amount of transmitted data
12 TX to RX transition 112 4.66 TX to RX transition
13 RX 184 6.47 Time depends on advertising interval and SCA
14 Post-processing and going

to standby
685 2.45 BLE protocol stack processes the received packets and sets up the sleep

timer in preparation for the next event. And then going to standby
afterwards

This is also the event occurring when a device is in beacon mode. For a non-connectable beacon, there
are no RX states during the advertising event, which reduces the power consumption further.

Figure 27. Beacon Event, Capture
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Table 8. Beacon Event, State Analysis

State Time [µs]
Current

[mA] Comments
1 Pre-processing 1160 3.26 RTOS wake-up, radio setup, XTAL guard time
2 Radio preparation 101 4.3 Radio is turned on and in transition to TX
3 TX 144 7.47 Tha radio transmits an advertisment packets with 3 bytes data on Channel

37. Time is dependent on amount of transmitted data
4 TX-to-TX transition 372 3.56 TX to TX transition
5 TX 144 7.47 Tha radio transmits an advertisment packets with 3 bytes data on Channel

38. Time is dependent on amount of transmitted data
6 TX-to-TX transition 372 3.56 TX to TX transition
7 TX 144 7.47 Tha radio transmits an advertisment packets with 3 bytes data on Channel

39. Time is dependent on amount of transmitted data
8 Post-processing and going

to standby
685 2.45 BLE protocol stack sets up the sleep timer in preparation for the next

event. And then going to standby afterwards

5.3.2 Standby
Standby is the power mode in between the advertising (and connection) event, which includes a VDDR
recharge. The recharge is a mandatory function during Standby in order to retain RAM and make sure that
the clocks are powered. The power consumption in between these recharges are around 70 nA, almost
too small to even measure. It is the average power consumption during Standby including recharge that is
defined as the Standby current, as about 1 µA in the CC2640, CC2640R2F and CC2650 data manual. It is
also important to know that this number is not fixed as the recharge pulses are dynamically adapted based
on the required time in Standby. If the measurement was performed immediately after a reset of the DUT,
there will be many more recharges between the advertising and connection events and over a few
seconds the amount of recharges will reduce to the mandatory 1 event. This means that Standby will go
from a slightly higher value, down to an optimum. The higher value has been measured to 2 µA.

Figure 28. VDDR Recharge
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For longer standby intervals, there will be a few more recharge pulses. One example is observed if the
DUT enters a connection. The Standby current can be measured by placing the markers between two
Advertising and Connection events. In Figure 29, the DUT is advertising with a 100 ms interval and there
is a recharge in between the advertising events; in this case, the resulting Standby current is 1.57 µA. The
Standby current will not go lower than this when advertising with a 100 ms connection interval.

Figure 29. Measuring Standby Current During Advertisement

When a connection has been established as described in Section 5.3.3, similar measurement can be
done, resulting in an optimum of 0.88 µA due to the long connection interval of 1 s (with two recharges in
between).

Figure 30. Measuring Standby Current During Connection
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5.3.3 Connection Event
When a connection has been established between a Peripheral and a Central device, they communicate
during connection events. The Central device operates as the master and the Peripheral device as the
slave.

All communication between two connected devices occurs on these connection events. They are
periodically with a configurable connection interval, ranging from 7.5 ms to 4 seconds.

Each event occurs on one of the 37 data channels and the Master always initiates the event, with the
slave listening. They can continue to communicate back and forth as much as they want during one
connection event.

Connection events occur even if neither side has data to send. This ensures that the link is still valid. If a
specified number of connection events occur without acknowledgment, the connection will be considered
lost.

In order to measure a Connection Event, the DUT must be connected to a peer device. By using BTool as
described in Section 4.4, a connection with 1 second connection interval is established.

To measure the average power consumption, the easiest way is to identify the re-occurrence and
measure the average current for that part. It will represent the average power consumption for that mode
device is running in. For a connection, it’s done by placing the one marker right after a connection event,
as shown in Figure 31, and the second marker after the next connection event, as shown in Figure 32.
The average current is then observed in Figure 32, as approximately 9.94 µA.

Figure 31. Connection Event, Marker #1 Placement
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Figure 32. Connection Event, Marker #2 Placement

The Connection Event can also be quantified to fully analyze the various states by using the Select
“Markers & Measurements”, similar as with the advertising event, as shown in Figure 33 and Table 9.

Figure 33. Current Consumption versus Time During a Single Connection Event
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Table 9. Connection Event, State Analysis

State Time [µs] Current [mA] Comment
1 Pre-processing 1165 3.22 RTOS wake-up, radio setup, XTAL guard time
2 Radio preparation 132 3.99 Radio is turned on and in transition to RX
3 Recieve (RX) 129 6.48 The radio receiver listens for a packet from the master. Time

depends on connection interval and SCA.
4 RX to TX transition 149 5.49 RX to TX transition
5 Transmit (TX) 90 7.66 The radio transmits a packet to the master on one of the 37

channels. Time is dependent on the amount of transmitted data
6 Post-processing and going to

standby
775 2.59 BLE protocol stack processes the received packets and sets up

the sleep timer in preparation for the next event. And then going
to standby afterwards

5.3.4 Power Consumption Calculation
The state analysis from advertising and connection states can be used to investigate how the battery life
varies depending on connection interval. For that purpose, a Power Calculation Tool is provided that can
be used to perform calculations for your custom application.
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